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 مهاربند همگرامعرفی   1

محور یا دهند و به سه دسته مهاربندهای همباربر جانبی هستند که با اضافه شدن به سازه، سختی جانبی آن را افزایش می یبه طور کلی مهاربندها اعضا

ای، شکل، دایره Iطعی به شکل مستطیل، توان از مقاشوند. اعضای مهاربندها را میبندی میقسیمتهای نوین مهاربندی محور یا واگرا و سیستمهمگرا، برون

طور هایی که به دیافراگم متصل نیستند بایستی خودداری نمود. هماندوبل نبشی و دوبل ناودانی انتخاب نمود. لازم به ذکر است از تعبیه مهاربندها در دهانه

تواند روی تیر، روی ستون لاقی دارند. این نقطه میتهمگرا شده و باهم  ها در یک نقطهکه از اسم مهاربندهای همگرا پیداست، اعضای مهاربندی یا امتداد آن

شوند. در این مهاربندها دو انتهای اعضای مهاربندی مفصلی بوده و اعضا دارای نیروی محور نیز شناخته مییا در صفحه قاب باشد. مهاربندهای همگرا با نام هم

باشد، بطوریکه از طریق سختی محوری ایجادشده در تیر و ستون به مقاومت در همچون خرپاهای قائم میکششی یا فشاری هستند. رفتار مهاربندهای همگرا 

 شود.شود که در ادامه انواع مهاربندهای همگرا معرفی میی مهاربندها، نوع مهاربند مشخص میپردازند. بسته به نقطه تلاقبرابر نیروهای جانبی می

 

 

 نگاه کی در همگرا یها یمهاربند انواع -1  شکل

 

 مهاربندهابا  آشنایی 2

 :نوع هستند 6مهاربندهای همگرا بر 

 مهاربند ضربدری -1

 مهاربند قطری -2

 مهاربند شورون هشتی -3

 مهاربند شورون هفتی -4

 مهاربند ترکیب شورون هفتی و هشتی -5

 شکل Kمهاربند  -6
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 گیریم.ا فرا میهای تازه از انواع مهاربندها رشویم، سپس پیکربندیمهاربندهای همگرا آشنا میدر ادامه ابتدا با انواع 

 

 مهاربند همگرای ضربدری 1. 2

کنند. های مقابل یک دهانه را به هم متصل میباشد که در آن دو عضو به صورت قطری، گرهمیترین نوع مهاربندهای همگرا، مهاربند همگرای ضربدری رایج

باشد. لازم به ذکر است مهاربند ضربدری بیشترین سختی را در بین انواع مهاربندهای ع مهاربند دارای ظرفیت کششی بالا و ظرفیت فشاری کم میاین نو

ما در مقابل ، اشود تا با قرارگرفتن در معرض زلزله، نیروی بیشتری به این مهاربند نسبت به سایر مهاربندها اعمال شودهمگرا داراست. این ویژگی موجب می

های معماری نظیر عدم امکان اجرای بازشو کند. شکل ظاهری مهاربندهای ضربدری باعث ایجاد محدودیتعمل می در محدود نمودن تغییر شکل سازه موفق

شود، صورت منقطع اجرا می ر به صورت پیوسته و قطر دیگر بهباشد. در مهاربندهای ضربدری معمولاً یک قطترین معایب آن میگردد و یکی از مهممی

شود، درحالیکه در اجرای سازی اتصال مهاربندهای ضربدری مفصلی فرض میشوند. همچنین در مدلسازی میسازی هر دو عضو پیوسته مدلدرحالیکه در مدل

 ده است.ضربدری قابل مشاهای از مهاربندهای همگرای باشد. در شکل زیر نمونهممکن است اندکی گیرداری پدید آمده  جزئیات اتصالات

 

 

 مهاربند ضربدری -2  شکل

 

 مهاربند همگرای قطری 2. 2

باید توانایی  مهاربند قطری شباهت زیادی به مهاربند ضربدری دارد، با این تفاوت که در این مهاربندها فقط یک عضو قطری در دهانه وجود دارد. این عضو

کس تعبیه شود که اگر تحمل کشش و فشار را دارا باشد. در مهاربندهای قطری، بایستی در همان راستا و در دهانه دیگری مهاربند قطری دیگری در جهت برع

شده است. با وارد شدن بارجانبی در حالت )الف(، نشان داده ( 3)مهاربند اولی دچار کمانش شود، مهاربند دوم پاسخگوی بارهای جانبی باشد. این امر در شکل 

تر است، چراکه اعضاء مهاربندی در دو دهانه یک باشد. ولی حالت )ب( قابل اطمینانکنند که این حالت صحیح نمیهمه مهاربندها در کشش یا فشار کار می

اند تا با تغییر جهت نیروی جانبی یکی از مهاربندها به کشش و دیگری به فشار کار کند. به طور کلی مهاربند قطری را قاب به صورت معکوس استفاده شده
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یک مهاربند قطری اجرا شده نمایش داده شده ( 4حاصل شود. در شکل )قطری اطمینان توان در یک جهت به کار برد که از عدم کمانش عضو تنها زمانی می

 است.

 

 

 جانمایی صحیح مهاربند قطری -3  شکل

 

 

 مهاربند قطری -4  شکل

 

 مهاربند همگرای شورون 3. 2

رسند. اگر این گره روی تیر باشد، شورون هفتی و اگر زیر تیر باشد، شورون هشتی در مهاربندهای شورون دو عضو مهاربندی بر روی یک گره به تلاقی می

ع مهاربندها فضای مناسبی برای کنند؛ زیرا  این نوکه شرایط خاصی از نظر معماری وجود دارد، استفاده میشود. طراحان از این مهاربندها عمدتاً زمانینامیده می
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هایی باشد و محدودیتهای معماری میدهند. مهاربند شورون هشتی بهترین گزینه از نظر پوشش محدودیتاجرای بازشوها و نورگیرها در اختیار طراحان قرار می

رد، درآن وجود ندارد. این دو مهاربند در مواردی در ترکیب با نظیر عدم امکان تعبیه بازشو چسبیده به زمین )نظیر درب ورودی( که در مهاربند هفتی وجود دا

 اند.مشخص شدهزیر های شوند. مهاربندهای همگرای شورون در شکلیکدیگر نیز به کار گرفته می

 

 

 مهاربند شورون هشتی -5  شکل

 

 

 مهاربند شورون هفتی -6  شکل
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 مهاربند شورون ترکیبی هفتی هشتی -7  شکل

 

 شکلKمهاربند همگرای  4. 2

شکل  Kکنند. مهاربندهای ای بر روی ستون مقابل قطع میگیرند و یکدیگر را در نقطهدر این نوع مهاربندها، اعضای قطری در یک طرف ستون قرار می

شکل  Kشوند. استفاده از دو مهاربند برند و به همین دلیل نامناسب ترین سیستم مهاربندی تلقی میالا میپتانسیل ایجاد مفصل پلاستیک در وسط ستون را ب

 (.8-دهد که به مهاربند لوزی شکل نیز معروف است)شکل به میئبه طور قرینه در یک طبقه، پیکربندی جدیدی از آن را ارا

 

های مهاربندی شکل در سیستم Kقررات ملی ساختمان، استفاده از مهاربندهای ممبحث دهم   3-4-2-4-3-10و  2-4-1-4-3-10طبق بندهای  نکته:

 باشد.غیرمجاز می
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 شکل   )ب( مهاربند لوزی شکلK)الف( مهاربند  -8  شکل

 

نماید و موجب تخریب آن شکل چنانچه عضو فشاری دچار کمانش گردد، عضو کششی نیروی زیادی به ستون وارد می Kلازم به ذکر است در مهاربندهای 

 شود. این امر در شکل زیرنشان داده شده است.می

  

 

 شکل Kعملکرد نامناسب مهاربند  -9  شکل

 

 مهاربندهای چند ردیفی 5. 2

م امکان طراحی یک مهاربند در آن تراز مورد استفاده قرار ی در یک یا چند طبقه، معمولاً به دلیل ارتفاع بالای طبقه و عدهای مهاربندی چند ردیفسیستم

ربری ها با کاهای فولادی نظیر سولهشود. این نوع سیستم در سازهای که در حد فاصل دو تراز مجاور، از دو یا چند ردیف مهاربند استفاده میگیرند. به گونهمی

 5-4-2-4-3-10و  3-4-1-4-3-10ای مربوط به بندهای صنعتی با ورزشی کاربرد بیشتری دارند. لازم به ذکر است این نوع مهاربندها بایستی ضوابط لرزه

ز هر ردیف اشاره نمود. ( در تراstrutsتوان به وجود اعضای افقی )از مبحث دهم مقررات ملی ساختمان را ارضاء نمایند. از شرایط عمومی مورد نیاز، می

هایی در جهت مخالف مورد چنین، مهاربندها در هر ردیف بایستی به صورت جفتها بایستی در محل اتصال هر عضو افقی در برابر پیچش مهار شوند. همستون

 است.دهای چند ردیفی در شکل زیر نمایش داده شدهای از انواع مهاربناستفاده قرار گیرند. نمونه

 



 

 

11 

 

 های متداول مهاربندهای چند ردیفیپیکربندی -10  شکل

 

ها، مهاربند ضربدری دو دهانه است که به ترین نوع این سیستمتوانند در دو یا چند دهانه به کار گرفته شوند. یکی از این متداولمهاربندهای همگرا می توجه:

 ( نمایش داده شده است.11شود. این نوع مهاربند در مقایسه با مهاربند ضربدری در شکل )یآن ترکیب مهاربند هفتی و هشتی نیز گفته م
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 ای از مهاربند دو دهانهنمونه -11  شکل

 

 اَبَر مهاربندها 6. 2

صورت به ضوع ابرمهاربدر  ستمگردد. ( مطرح میMega bracesندها )کارگیری مهاربندها در چند دهانه مو سی سنتی مهاربندی ابرمهاربندها با ترکیب  های 

سازه مانند یک چشمه مهاربندیموجب می سازهشوند که تمام  صی موجب شده عمل نماید و اغلب در  ستم با چیدمان خا سی های بلندمرتبه کاربرد دارند. این 

 (.12دهد )شکلرا نیز به خوبی کاهش می ای سازههای لرزهشود و از طرفی پاسخهای ساخت میجویی در مصالح و هزینهصرفه

 

 

 ر مهاربندهاای از پیکربندی اَبَنمونه -12  شکل

 

 ایمهاربند دروازه 7. 2

جدیدی از  همانطور که اشاره شد، مهاربندهای همگرا اغلب با مشکلات معماری از جمله نبود فضای کافی برای ایجاد بازشو مواجه هستند. بنابراین نوع

شد، اما اعضای باگردد که از نظر هندسی مشابه مهاربندهای همگرای شورون هفت و هشتی میای معرفی میمهاربندهای همگرا تحت عنوان مهاربند دروازه

شوند. محل شکستگی به وجود آمده بین دو عضو توسط عضو سومی به محل اتصال تیر و ستون هایی به هم متصل میآن مستقیم نیستند و با شکستگی
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شود. اگر این ای نیز شناخته میهشکل و مهاربند خیم Yای، مهاربند چند ضلعی، مهاربند های دیگری نظیر مهاربند پردهای به نامشود. مهاربند دروازهمتصل می

ای عضو تشکیل شده باشد به آن مهاربند دروازه 3گویند. چنانچه این مهاربند از ای دو لنگه نیز میباشد، به آن مهاربند دروازه عضو تشکیل شده 6مهاربند از 

 ند.او دو لنگه نشان داده شدهای تک لنگه ( هر دو نوع مهاربند دروازه13گویند که در شکل )شکل می Yتک لنگه یا 

 

 

 ای   )الف( دو لنگه   )ب( تک لنگهمهاربند دروازه -13  شکل

 

چنین تأثیر پارامترهای مختلف مانند مشخصات اعضای ای بسیار اهمیت دارد. همنامهای به دلیل عدم وجود ضوابط دقیق آییناجرای صحیح مهاربندهای دروازه

نمایند. لازم به ذکر است در پذیری را در حد معمول تأمین میپذیری بایستی به دقت بررسی شوند. این مهاربندها سختی و شکلمهاربند، ضریب رفتار و شکل

شوند، اما مفصلی گرفته میه قاب و به یکدیگر مفصلی در نظر بکند. اغلب اتصالات اعضای مهاربندی پذیری لازم را فراهم میهای شدید عضو مایل شکلزلزله

های ای در جهت عمود بر صفحه خواهد شد. به بیان دیگر در زلزلهبودن اتصال اعضای مهاربندی به یکدیگر در گره میانی باعث ناپداری هندسی مهاربند دروازه

ه عضو باعث خروج گره کنند. فشاری بودن سشدید، سه عضو متصل به گره میانی در یک طرف به صورت کششی و در طرف دیگر به صورت فشاری عمل می

 اند.اده شدهگردد، بنابراین اتصالات در این نقطه بایستی صلب باشد. موقعیت گره میانی، اعضاء کششی و فشاری در شکل زیر نمایش دمیانی از صفحه می
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 ایگره میانی و عملکرد اعضای مهاربند دروازه -14  شکل

 

گرفته هرچه گره میانی های میانی دارد. طبق تحقیقات صورتشود ارتباط مستقیمی با محل گرهای، فضایی که برای بازشو در نظر گرفته میمهاربند دروازه در

 ود.شزرگ فراهم میبیابد ولی در عوض امکان ایجاد بازشوهای پذیری و ضریب رفتار کاهش میتر باشد، سختی، شکلبه گوشه قاب نزدیک

ای ممنوع نشده است، اما تا حد امکان بهتر است از استفاده از آن اجتناب نمود. یکی از دلایل مفصلی نبودن گره میانی ای در آیین نامهاستفاده از مهاربند دروازه

ه تصال پیوسته برای حداقل دو عضو از سگردد. حتی اگر بتوان برای این اتصال با در نظر گرفتن ااین است که موجب حرکت خارج از صفحه و ناپایداری می

مهاربندی خواهد شد و بایستی از  عضو، صلبیت ایجاد نمود ، بازهم توجیه اقتصادی نخواهد داشت؛ زیرا که گیرداری اتصال موجب ایجاد لنگرهایی در اعضاء

ستفاده از این مهاربند، نزدیک بودن گره ادیگر از دلایل اجتناب از  مقاطع بزرگتری برای اعضاء استفاده نمود، در نتیجه طراحی آن غیراقتصادی خواهد بود. یکی

کنند کنند و تا حد امکان سعی میکه نیاز به استفاده از بازشوهای بزرگ باشد از این نوع مهاربند استفاده میمیانی به گوشه قاب است؛ چراکه طراحان زمانی

 گردد.پذیری میمر موجب کاهش سختی و شکلاتر شود ولی این های میانی به گوشه قاب نزدیکگره

 

 مزایا و معایب مهاربندهای همگرا 8. 2

 گیرند:ر میمهاربندهای همگرا نیز مانند هر المان مؤثر در رفتار سازه دارای مزای و معایبی هستند که در ادامه مورد بررسی قرا

 

 ی مهاربندهای همگرامزایا
 

 سختی بالای سیستم 

  جانبی سازه تا حد زیاد به دلیل سختی زیاد سیستم مهاربندیکنترل شدن تغییر مکان 

 طراحی به نسبت ساده و عدم نیاز به نیروی تخصصی جهت اجرا آن 

 ای به دلیل دریفت پایین طبقاتآسیب کمتر به اجزای غیرسازه 

 اقتصادی بودن این سیستم نسبت به سیستم قاب خمشی و قاب مهاربندی شده واگرا 

های قابهای متعارف با  مجاز طبقات اسکککت. برای سکککازه کنترل دریفتای، نامههای آیینیکی از کنترل افزار ایتبسطراحی اسککککلت فولادی با نرمدر 

های  شککده، به دلیل سککختی بالای مهاربندها اکور مواقع یا شککاید به جرات بتوان گفت اصککلاً نیازی به کنترل دریفت طبقات نیسککت. برخلاف قابمهاربندی

شده، این کنترل در مورد قاب شی، بهمهاربندی  شد، های خم شاره  شود. همانطور که ا سبت کمتر، حتماً باید چک  سختی به ن ستمدلیل  های مهاربندی از سی

شند که این ویژگی یکی از مهمسختی بالایی برخوردار می شکلترین نقاط قوت آن محسوب میبا سختی بالا موجب کاهش  پذیری و در شود. اما از طرفی 

 .گرددنتیجه کاهش جذب و استهلاک انرژی زلزله می

https://sabzsaze.com/product/steel-structures-course/
https://sabzsaze.com/drift-check/
https://sabzsaze.com/drift-check/
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 معایب مهاربندهای همگرا
 

  ری و قطری )این محدودیت در ایجاد بازشوهای مانند تعبیه درب و پنجره به ویژه در مهاربندهای نوع ضربدایجاد محدودیت ازنظر معماری برای

 مورد مهاربندهای شورون هفتی و هشتی تقریباً مرتفع شده است(

 راپذیری نسبت به قاب خمشی و قاب مهاربندی شده واگکاهش شکل 

   قاب مهاربندی شده واگرا قابلیت جذب و استهلاک کمتر انرژی زلزله نسبت به 

 کاریاحتمال کمانش مهاربند و تأثیر آن بر روی نازک 

 

هریک  اند که به اختصار به معرفیناپذیر پدید آمدههای نوینی نظیر مهاربند زانویی و مهاربند کمانشبه منظور بهبود عملکرد مهاربندهای همگرا، سیستم

 پردازیم.می

 

 (KBFمهاربند زانویی) 9. 2

اند. این سیستم ها نشدهنامهاند و تاکنون وارد آیینباشند که به منظور پوشش نواقص دیگر مهاربندها پیشنهاد شدهمهاربندهای زانویی سیستم نوین مهاربندی می

ی به تیر و ستون سر عضو زانوی است. دوباشد، با این تفاوت که علاوه بر عضو قطری، از یک عضو زانویی نیز تشکیل شدهمشابه مهاربند همگرای قطری می

پذیری لازم بر عهده شود. باتوجه به سختی قابل توجه عضو قطری، تأمین شکلمتصل بوده و از نقطه دیگری )معمولا وسط عضو( به عضو قطری متصل می

رار گرفتن سازه تحت تحریک زلزله عضو قطری و قاب آن است، به طوریکه با ق های مهاربند زانویی قابل تعمیر بودنترین ویژگیباشد. از مهمعضو زانویی می

توان این عضو را پس شود. بنابراین میشود؛ زیرا مفصل پلاستیک در عضو زانویی تشکیل میسازه در حالت الاستیک باقی مانده و عضو زانویی دچار خرابی می

های مهاربندی، خسارات وارده اربندی زانویی نسبت به سایر سیستمنمود. سیستم مه جوییهای مربوط صرفهاز اتمام زلزله تعمیر و یا جایگزین کرده و در هزینه

های بزرگ پردازد و در زلزلههای کوچک، تنها عضو قطری با تأمین سختی لازم به مقابله با ارتعاش میرساند. در زلزلهای را به حداقل میبه اعضا غیرسازه

 اند.( نمایش داده شده15ی در شکل )ای از مهاربندهای زانویشود. نمونهرد عمل میپذیری مناسب واعضو زانویی با تأمین شکل

 

 

 هایی از پیکربندی مهاربندهای زانویینمونه -15  شکل
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 (BRBناپذیر)مهاربندهای کمانش 10. 2

ف از کمانش ناپذیر به منظور بهبود عملکرد مهاربندهای همگرا پدید آمدند و متشکل ازیک هسته فولادی به همراه غلاف هستند که غلامهاربندهای کمانش

و این امر  دهندان میمقاومت خوبی از خود نشکند. بنابراین در این مهاربندها اعضاء مهاربندی هم در فشار و هم در کشش هسته فولادی در فشار ممانعت می

بخشد. ملات یا بتن دور هسته فولادی مانند قیدی برای مهاربند عمل کرده دهد و عملکرد مهاربند را ارتقاء میپذیری قاب در مقابل زلزله را افزایش میشکل

نامه مجاز ر برای انواع مهاربندهای همگرایی که در آیینناپذیمهاربند کمانش کند. استفاده ازو با کاهش لاغری مهاربند از کمانش فشاری آن نیز جلوگیری می

پذیری بالا های مهاربندی همگرا و شکلباشد. این نوع مهاربندها به دلیل دارا بودن سختی قاباند )به جز مهاربند همگرای ضربدری( قابل اجرا میاعلام شده

 باشند.ها میگزینه مناسبی برای اجرا در سازه

 

 

 ناپذیرپیکربندی مهاربند کمانش -16  شکل

 

 

 نمونه اجرا شده مهاربند کمانش ناپذیر -17  شکل

 

 است.مبحث دهم مقررات ملی ساختمان اضافه شده 4-4-3-10ناپذیر در بندضوابط مربوط به مهاربندهای کمانش
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 مهاربندهای ویژه و معمولیتفاوت  11. 2

گیرد در نظر می (Ru)عنوان ضککریب رفتاری نیروی زلزله بهضککریبی را برای محاسککبه 2800نامه آید آیینطورکلی وقتی حرف از ویژه و معمولی پیش میبه
ستم2800نامه آیین 4-3)جدول  سی ست. در  سازه ا ستم باربر جانبی  سی ضریب تابع نوع  ضریب مقدار ( که این  سبت به بزرگهای از نوع ویژه این  تری ن

ی وارد برسازه )شود نیروی زلزلههای نوع معمولی دارد و این باعث میسیستم
ABI

Ru
های معمولی کمتر شود. درنتیجه های ویژه، نسبت به سیستم( در سیستم

از خود در زلزله نشان  پذیرتریار انعطافداشت که رفتسیستم معمولی خواهیم به نسبتپذیرتر تر و شکلهای ویژه یک قاب سبکتوان گفت که در سیستممی
که در ی از اعضا انتظار داریم، درصورتیشتریبما رفتار فرا ارتجاعی )خارج از ناحیه الاستیک(  ،های ویژهدر سیستم که توان استنباط کردهمچنین میدهد. می

ستم ستیک باقی میهای معمولی مهاربندیسی ضای مهاربندی اجازه میمانند. این بدان معها در ناحیه الا ستم مهاربندی ویژه ما به اع سی ست که در  دهیم نا
پذیر را داشته باشند و مول یک فیوز عمل کنند تا سایر های همگرای ویژه، مهاربندها باید نقش یک عضو شکلوارد ناحیه پلاستیک شوند. درواقع در سیستم

های های ویژه استهلاک انرژی بیشتری نسبت به سیستمستیک باقی بمانند. به همین علت سیستمها در ناحیه الااعضای قاب مهاربندی یعنی تیرها و ستون
 توضیح داده است. ریز صورتبهمعمولی دارند. مبحث دهم مقررات ملی ساختمان در این مورد 
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 مهاربندهای همگرای ویژه مختلط 12. 2

 گیرد.های مورد نیاز برای کشش و فشار براساس مشخصات مقاطع مختلط انجام میمقاومت شود و محاسبهها از مقاطع مختلط استفاده میدر این نوع قاب
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 محدودیت خروج از مرکزیت از دید مبحث دهم مقررات ملی ساختمان 3

شرایطی مجاز اعلام کرده شروط به  ساختمان خروج از مرکزیت تا کمتر از ارتفاع تیر را م ست. برای مبحث دهم مقررات ملی  شده همگرا های مهاربندیقابا

 معمولی و ویژه به ترتیب داریم:

 

 

 

خروج از  ساختمان یدهم مقررات مل مبحث 2-1-6-3-10و 2-4-4-3-10ی ناپذیر و همگرای مختلط نیز طبق بندهاشده کمانشهای مهاربندیبرای قاب

 لیتبد سبب که تیمرکز از خروج تیمحدود با رابطه در لی ساختمان در ویرایش قبلیاست. مبحث دهم مقررات ممرکزیت کمتر از عمق تیر مجاز اعلام شده

 :است داده حیتوض ، اینگونهشودی( میو هشت ی)شورون هفت همگرا به واگرا مهاربند
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 همگرا یمهاربند مجاز یمرکز برون -18  شکل

 

مورد  رای آن رعایت شود. درب 8ای مربوط به شورون نامهباشد، مهاربند از نوع شورون هشتی است و باید الزامات آیین be<dدرواقع اگر در شکل فوق 

شکل )ردیگ قرارها باید روی محور میانی جان تیرِ متصل به مهاربند مهاربندهای همگرا باید به این نکته دقت شود که محل تلاقی محورهای اعضای مورب آن

 با مهاربند یمحورهاتلاقی عدم  یرانوعی ببه و برای خروج از مرکزیت حداقلی را در نظر گرفته نامهآیینهم گفته شد، فوق  دربند کهطور ( که البته همان19

محورهای مهاربندی ها روی محور  ولی تا حد امکان در اجرای مهاربندها باید دقت کافی به خرج داد تا محل تلاقی قائل شده است فیتخف ،ریت یانیم محور

ناشی از  Pxhیک نیروی لنگر اضافی  و این باعث ایجاد قرارگرفتهمحل تلاقی خارج از محور تیر  (،20مطابق شکل ) زیرا در غیر این صورت؛ میانی تیر بیفتد

  .کندو لنگر خمشی مازادی را به سازه تحمیل می شودنیروی محوری تیر می

 

 

 همگرا مهاربند یاجرا حیصح نحوه -19  شکل
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 ریت یانیم محور از خارج مهاربندها یانیمحورم یتلاق محل -20  شکل

 

 پذیری و ایجاد بازشومقایسه مهاربندهای همگرا از لحاظ سختی، شکل 4

یراقتصادی غ ای نیز به دلیل ناپایداری خارج از صفحه وباشد و مهاربندهای دروازهنامه مجاز نمیشکل طبق آیین kهمانطور که اشاره شد، استفاده از مهاربندهای 

 های بلند مرتبه، ابََر مهاربندها و مهاربندهایهای کوتاه مرتبه و با رعایت تمهیدات خاص استفاده شود. معمولاً در سازهشود، مگر اینکه در سازهبودن پیشنهاد نمی

رون که گیرند که هم اقتصادی بوده و هم کارایی مطلوبی دارند. حال به مقایسه مهاربندهای همگرای ضربدری، قطری و شوچند ردیفی مورد استفاده قرار می

 پردازیم.شوند، میهای فولادی به طور متداول استفاده میدر سازه

باشد و معمولاًعملکرد بهتری نسبت به مهاربند قطری ا در میان مهاربندهای همگرا دارا میپذیری رمهاربند همگرای ضربدری بیشترین سختی و کمترین شکل

ای را به صورت فشاری و کششی دارا باشد که این امر مسلتزم استفاده داراست؛ زیرا در مهاربند قطری یک عضو بایستی به تنهایی توانایی تحمل بارهای لرزه

ار بحرانی و کاهش طول آزاد مهاربند، با افزایش ب عضو قطری به صورت قرینه در دهانه کناری نیز مورد استفاده قرار گیرد. باشد و یااز سطح مقطع بالاتری می

افتد؛ زیرا کمانش مهاربند در اثر نیروی فشاری با طول مهاربند ارتباط افزایش مقاومت زیادی در مهاربندهای ضربدری نسبت به مهاربندهای قطری اتفاق می

گیرند و مهاربندهای قطری نیز فضای آزاد بیشتری را نسبت به د. از نظر ایجاد بازشو، مهاربندهای شورون با توجه به شکل هندسی خود در اولویت قرار میدار

باشند؛ هاربند در اجرا میترین نوع م(. چنانچه شرایط معماری خاصی وجود نداشته باشد، مهاربندهای ضربدری متداول21مهاربندهای ضربدری دارا هستند )شکل 

 کنند.زیرا سختی زیادی برای سازه فراهم می
 

 

 بازشو جادیا نظر از همگرا یمهاربندها سهیمقا -21  شکل
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 مقایسه مهاربندهای همگرا از نظر کمانش و ایجاد مفصل پلاستیک 5

افتد. ایجاد کمانش در عضو فشاری موجب های مهاربندی همگرا که به ظرفیت نهایی خود رسیده باشند، تسلیم در کشش یا کمانش در فشار اتفاق میدر قاب

شکل یاافت مقاومت و خرابی می صورت بگیرد. چنانچه مقطع مهاربند قوطی  صفحه  صفحه یا خارج از  صورت داخل  ست به  ای دایره گردد. کمانش ممکن ا

شد، معمولاً کمانش خارج از صفحه صورت گرفته و مفصل پلاستیک در ورق اتصال تشکیل می شد، کمانش داخل با گردد. اگر محور ضعیف داخل صفحه با

ط عضو شود. در مهاربندهای ضربدری ایجاد اتکای جانبی توسط عضو کششی در وسصفحه صورت گرفته و مفصل پلاستیک در خود مهاربند تشکیل می

کننده در روی تیر به دهد؛ همچنین نیروی نامتوازنفشاری، کمانش عضو فشاری و مکانیسم تشکیل مفصل پلاستیک در وسط مهاربند را تحت تأثیر قرار می

شکلشکل نیروی محوری بزرگی ظاهر می شتری تغییر  شی بی شده و های جانبی درگردد. برای مهاربندهای قطری در طول کمان در نتیجه کمانش  آن ایجاد 

 تیمز کی 8با شورون  سهیمقا در 7که شورون  دیسر جهینت نیتوان به امی 8 و 7 شورون یمهاربندها تردقیق یبررس باشوند. موضعی کمتری را متحمل می

. افتدمیهنگام زلزله به تعویق  هاهاربندم نیاوقوع پدیده کمانش برای  درنتیجهشود، مهاربندها تحت بارهای ثقلی، نیروی کششی ایجاد می نیا در ؛دارد مهم

  اندازد.وقوع پدیده کمانش را جلو می کهشود تحت اثر بارهای ثقلی نیروی فشاری در مهاربند ایجاد می 8که در مهاربند شورون درصورتی

 

 

 زلزله هنگام کمانش افتادن جلو و یثقل بار اثر تحت 8 شورون مهاربند افتادن فشار به -22  شکل

 

 مقایسه مهاربندهای شورون از لحاظ معماری و مشکلات اجرایی  6

اما این  د،نتوجه معماران قرار دار وردبه علت ایجاد امکان تعبیه بازشوهایی نظیر در و پنجره، بیشتر م 8و  7های شورون ز بین مهاربندهای همگرا، مهاربندا

فتار متفاوتی که نسبت به ربه دلیل اتصال به تیر و  8و  7کند؛ زیرا مهاربندهای شورون و حتی مجری را سخت میانتخاب کار مهندس محاسب و سازه 

 د.نطلبای را میو البته محتاطانه گیرانهای سختنامهمهاربندهای ضربدری و قطری دارند، رعایت ضوابط آیین

باشد. از لحاظ اتصال دارا می 8فضای بیشتری نسبت به شورون  7ورون شاز لحاظ ایجاد بازشو، مهاربند  که دهدمی نشان 8و   7ی مهاربندهای شورون مقایسه 

تصل شود. مون باید به فونداسی 7ترین طبقه نیاز به اتصال مهاربند به فونداسیون ندارد، این درحالی است که شورون در پایین 8به فونداسیون، مهاربند شورون 

مول عدم امکان عبور خودرو( که کند )در طبقه اول از لحاظ معماری محدودیت ایجاد می 7همچنین شورون  و است ترساده یاندک 8 ونشور یاجرا درنتیجه

ها، شود. از لحاظ طراحی ستوناستفاده می 8ترین طبقه از شورون در پایین تنهااستفاده کرد و  7از شورون تمام طبقات  درتوان برای حل این مشکل می

کنند ولی در های آخرین طبقه نیروی زلزله را از مهاربندها دریافت میستون 7باشند؛ چراکه در شورون می 7تر از شورون کمی سبک 8ها در شورون ستون

 کند.تر انتقال پیدا میهای یک طبقه پاییننیروی زلزله به ستون 8شورون 
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 مهاربند شورون هفتی و هشتیهای محدودیت -23  شکل

 

 های مهاربندیمقایسه ضریب رفتار قاب 7

پذیری و اتلاف انرژی شود. این پارامتر میزان شکلنمایش داده می uRرود و با وی زلزله به کار میهای خطی به منظور محاسبه نیرضریب رفتار سازه در تحلیل

  است. کرده ای ارائههای مختلف سازهی سیستمامعرفی ضریب رفتار ساز پرداخته و آن را بر به 2800نامه آیینکند. در ناحیه غیرخطی را تعیین می

پذیرتر است، ضریب رفتار آن نیز بزرگتر خواهد بود. سیستم مهاربندی واگرای ویژه نیز به دلیل های مهاربند ویژه رفتار سازه شکلبا توجه به اینکه در سیستم

های مهاربندی همگرا ضریب رفتار بزرگتری دارد؛ در مقابل از سختی کمتری برخوردار پذیری بیشتر نسبت به سیستمرژی و شکلتوانایی بالا در استهلاک ان

دهند ناپذیر به دلیل ممانعت از کمانش اعضاء مهاربندی فشاری، مقاومت بالایی در کشش و فشار از خود نشان میتاب یا کمانشباشد. مهاربندهای کمانشمی

 ریب رفتار بالایی نسبت به سیستم همگرا دارد. پذیری بالایی دارند در نتیجه ضلو شک
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 مقایسه رفتار مهاربندهای همگرا در هنگام وقوع زلزله 8

با درک کامل رفتار تار هریک آشنا شویم. هر کدام از انواع مهاربندهای همگرا دارای رفتار متفاوت به هنگام وقوع زلزله هستند. در ادامه قصد داریم تا با رف

 ازه انتخاب کند.ستواند بهترین سیستم مهاربندی را برای مهاربندها، طراح می

 

 ن هفتی و هشتیومهاربندهای شور 1. 8

 رید:ع زلزله بیشتر آشنا شویم، قابی به شکل زیر در نظر بگیوهنگام وق 8و  7برای اینکه با رفتار مهاربندهای شورون 

 

 

 یجانب بار اثر تحت هشتی شورون یمهاربند قاب -24  شکل

  

گیرد.  فشار قرار تحت BDتحت کشش و مهاربند  ADاست که مهاربند قرارگرفته است که منجر شده Fفوق تحت اثر نیروی جانبی  قاب مهاربندی شده 

نیروی فشاری وارده بر عضو مهاربندی از ظرفیت کمانشی آن کمتر باشد، مهاربند چه نیروی جانبی وارد بر قاب مقدار قابل توجهی نداشته باشد، بطوری که چنان

توان فهمید که کنند که با تحلیل سازه میکند و هر دو مهاربند در محدوده الاستیک خود قرار داشته و سهم برابری از نیروی جانبی را تحمل میکمانش نمی

مقدار آن برابر با 
F

2cosα
یکی از نوع کششی و دیگری از نوع فشاری است که به وسط  ولی ، هر چند مقدار نیروها برابرزیرمطابق شکل  است. در این حالت ، 

ها صفر ی متمرکز قائم یکدیگر را خنوی کرده و برآیند آنهاشود که نیرومشخص می زیر مطابق رابطهدر وسط تیر،  شوند. از تجزیه این نیروهاتیر اعمال می

ای که در وسط تیرِ متصل به خواهد بود. به نیروی افقیِ خنوی نشده Fها برابر جهت و برآیند آنهای افقی نیروها، هملفهمؤی است که شود. این درحالمی

 شود.می است، نیروی متوازن تیر گفتهمهاربند ظاهر شده

 

∑ fx =0 → Pb=(
F

2cosθ
×cosθ)+(

F

2cosθ
×cosθ)=F 

∑ fy =0 → Fy= (
F

2cosθ
×sinθ) − (

F

2cosθ
×sinθ)=0 
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 کنندیم وارد ریت به کم یبارجانب تحت 8 شورون یمهاربند یاعضا که یمتوازن یروهاین شینما -25  شکل

 

ضو بیشتر باشد، در این صورت عضو ( از ظرفیت کمانشی عBD)عضو که نیروی فشاری وارد بر عضو مهاربندیطوریکه مقدار بار جانبی زیاد باشد بهدر صورتی

BD که که عضودانیم که مقاومت فشاری یک عضو فولادی از مقاومت کششی آن کمتر است؛ بنابراین زمانیمی. کندکمانش می BD  تحت فشار کمانش

 کند. ی زیادی را به تیر اعمال میدر اثر بار جانبی، نیروی کشش (ADشود ولی در عوض عضو کششی مهاربند)کند، نیروی کمی از جانب آن به تیر وارد میمی

 

 هشتی شورون مهاربند یفشار عضو کمانش -26  شکل

 

افقی مطابق رابطه زیر، ر راستای قائم و نیروهای وارده د این نیروهای وارد شده به تیر مطابق شکل زیر به دلیل اختلاف زیادی که با هم دارند، پس از تجزیه

را نیروی به همین دلیل آن شود.ر میبه هم ریختن توازن نیروها در تی موجب کنند کهدر راستای قائم نیروی متمرکز نسبتاً زیادی را به وسط تیر اعمال می

ین نقطه خواهند شد که بایستی در طراحی خمشی زیادی در ا این نیرو با ایجاد نیروی متمرکز زیادی در وسط تیر منجر به ایجاد لنگرنامند. نامتوازن کننده می

 – فتار صرفاً خمشی به رفتار  تیررشود که رفتار المان را از قابل توجهی به تیر متصل به مهاربند وارد می همچنین نیروی برآیند افقی سازه لحاظ شود.

ستون باید انجام  - بر اساس ضوابط تیر صل به مهاربندی شورون هفتی و هشتیتیر مت احیکند که باید طرتبدیل میخمشی(  -)یعنی رفتار محوری ستون

 گیرد.

∑ fx =0 → Pb=(Pc×cosθ)+(Py×cosθ)=(Pc+Py)cosθ 

∑ fy =0 → Fy=(Pc×cosθ)-(Py×cosθ)=(Py-Pc)sinθ 
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 کنندیم وارد ریت به ادیز یبارجانب تحت 8 شورون یمهاربند یاعضا که ینامتوازن یروهاین شینما -27  شکل

 

باشد شوند. حالت اول تسلیم تیر ضعیف به دلیل کمانش بادبند فشاری میهای مهاربندی شورون معمولاً به دو صورت دچار خرابی میبا وارد شدن زلزله، قاب

گردد. حالت دوم تسلیم تیر قوی به دلیل کمانش عضو می، اعمال آن به تیر و ایجاد مفصل پلاستیک در تیر کنندهوجود آوردن نیروی نامتوازنکه موجب به

 باشد.فشاری پس از عضو کششی می

تواند مقادیر مختلفی داشته باشد. در واقع چنانچه مقدار لاغری شود که نیروی نامتوازن کننده قائم وارد بر تیر، بسته به اینکه مهاربند لاغر یا چاق باشد، میتوجه

مهاربند ) 
Kl

r
مبحث دهم مقررات ملی  2-5-1-4-3-10در بند شود. محدودیت آیین نامه بیشتری برای آن لحاظ می یادی باشد، به این معناست که( مقدار ز 

√4معمولی به مقدار های شورون هفتی و هشتی ساختمان، لاغری مهاربند
E

Fy
= 4√

2×106

2400
= برای مهاربندهای شورن   2-5-2-4-3-10و در بند  115

 شود.محدود می 200ویژه، این مقدار به  8و  7

 ساختمان داریم: مبحث دهم مقررات ملی 3-4-2-10بند در 

 

 

 

مقاومت شود و ای اگر مهاربند فشاری مقدار لاغری بیشتر از محدودیت آیین نامه داشته باشد، لاغر محسوب میا توجه به محدودیت های آیین نامهبنابراین ب

 یی آن طبق رابطه(، مقدار به مراتب بزرگتری دارد که در نتیجهPy=AgFyکمانشی کمی خواهد داشت ولی نیروی کششی مهاربند )

 ∑ fy =(Py-Pc)sinθ  
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شود مهاربند چاق محسوب می ه کمتر باشد،اما اگر مقدار لاغری مهاربند فشاری از حد آیین نام ،کننده مقدار قابل توجهی خواهد شدنامتوازنمقدار نیروی قائم 

 بق رابطهطو مقاومت کمانشی قابل توجهی دارد که در مقایسه با نیروی کششی مهاربند تحت کشش، اختلاف کمی دارد که در نتیجه آن 

 ∑ fy =(Py-Pc)sinθ شود. متحمل می شود ولی در عوض مقدار نیروی محوری )افقی( زیادی راکننده ناچیزی به تیر وارد میمقدار نیروی نامتوازن

 ای طراحی شود که لاغری آن کمتر از لاغری آیین نامه شود. بنابراین باید سعی شود تا حد امکان مهاربند به گونه

صفر به یکدیگر  نسبت ر محل اتصال مهاربندهاتغییر مکان قائم د ،باشد( باشد. اگر تیر صلب پذیرانعطاف) غیرصلبیا  د صلبتوانمیدر قاب تحت بررسی تیر 

به علت اینکه  ،ر تیر صلب نباشداست که نتیجه این خواهد شد که میزان افزایش طول مهاربند کششی دقیقا با کاهش طول مهاربند فشاری برابر است ولی اگ

)کاهش رابر نخواهند بودا یکدیگر بدها بتغییر طول مهاربن ،)به دلیل زیاد بودن نیروی کششی نسبت به فشاری(دهدمیوسط تیر به سمت پایین تغییر مکان 

نیروی نامتوازن وجود خواهد  بر نیستند وبرا هانیروهای مهاربند بازهمطول مهاربند فشاری بیشتر از افزایش طول مهاربند کششی خواهد بود و البته در این حالت 

را به تیر  ایملاحظه قابل کننده ازننیروی نامتو با لاغری زیاد، نیست و استفاده از مهاربندهای پذیرامکان عملاًداشت(. با توجه به اینکه استفاده از تیر صلب 

 کنند.میصیه کم را توبا لاغری مهاربندهای، استفاده از هانامهآیینو همچنین  شدهانجام، تحقیقات کندمیوارد 

 

 

 یکشش مهاربند طول شیافزا با یفشار مهاربند طول کاهشبرابری  جهیدرنت و صلب ریت -28  شکل

 

 

 یکشش عضو طول شیافزا از یفشار عضو طول کاهشبیشتر بودن  و رصلبیغ ریت -29  شکل
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 زلزله هنگام در هفتی و هشتی شورون مهاربند عملکرد -30  شکل

 

 دهند:کننده وارد بر تیر دو راهکار به شرح زیر ارائه مینامتوازنها برای کاهش نیروی زیاد نامهآیین

کننده به جای تیر به ستون دوخت های دوخت )زیپرها( در محل برخورد مهاربند با تیر در طبقات که در این صورت نیروی نامتوازناستفاده از ستون (1

های مزیع جابجایی نسبی طبقات و جذب انرژی پیشنهاد گردید و به سیستهای دوخت به دلیل ضعف مهاربندهای شورون در توشود. ستونوارد می

قوع شود در وباعث می این سیستمشود. همچنین ن اجرا نمیترین طبقه ساختماپایینمهاربندی زیپی نیز معروف شدند. در مواردی ستون دوخت در 

 یکنواخت در ارتفاع سازه گسترش یابد.  صورتبهزلزله خرابی 

زیرا از بالا و ؛ شودمیوارد  تیر به وسط کننده کمینامتوازننیروی این صورت ترکیبی که در  صورتبه شورون هفتی و هشتیاز مهاربند استفاده  (2

 .کنندخنوی می تا حد زیادی پایین نیروهای کششی و فشاری وارد بر تیر همدیگر را

 

 

 کنندهنامتوازنراهکارهای کاهش نیروهای  -31  شکل
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 دوخت ستون همراه همگرا شده یمهاربند قاب نمونه -32  شکل

 

 

 هفتی و هشتی یبیترک یها یمهاربند در ریت بر وارد یروهاین اثر شدن یخنث -33  شکل

 

 شکل Kمهاربندهای  2. 8

هایی دارد؛ کند. استفاده از این مهاربندها محدودیتها وارد مینیروی نامتوازن کننده زیادی به ستون متصل به آنشبیه مهاربندهای شورون نیز  مهاربندهااین 

مبحث دهم  ویرایش سوم تواند باعث فروپاشی کل ساختمان شود.زیرا عدم اجرای صحیح و وارد شدن نیروی برشی زیادی که از طرف مهاربندها به ستون، می

ند ممنوع جدید این مبحث استفاده از این نوع مهارب هایدر ویرایش ، ولیداندهای یک و دوطبقه مجاز میها را در ساختمانمقررات ملی ساختمان استفاده از آن

 شده است.
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 شکل k یمهاربند در ستون بر وارد کننده نامتوازن یروهاین -34  شکل

 

 مهاربندهای ضربدری 3. 8

مقاومت ناچیزی دارند  ، پس از کمانشهاکنند. مهاربندها برخلاف ورقکمانش می ،گیرندها وقتی تحت اثر نیروی فشاری بیشتر از ظرفیت خود قرار میمهاربند

عضو فشاری مهاربند تحت اثر . د ماندبت خواهثا ها،آنشد و نیروی محوری فشاری وارده بر  صفر خواهد تقریباًسختی عضو  هاآنو پس از وقوع کمانش در 

شاری مهاربند کمانش کند. فاین کاهش طول بیشتر خواهد شد تا اینکه عضو  ،نیروی فشاری وارده با کاهش طول همراه هست که با افزایش نیروی فشاری

 یابد. در این حالت بدون اینکه نیروی محوری آن افزایش یابد، کاهش طول عضو ادامه می

 

 

 یضربدر یمهاربند ستمیس یسخت رفتن نیب از و یفشار عضو کمانش -35  شکل

 

شود. افزایش یابد و این باعث افزایش لنگر خمشی در وسط مهاربند مینسبت به حالت اولیه خود افزایش می کم کمتغییر مکان وسط عضو مهاربند فشاری 

مفصل پلاستیک خمشی تشکیل شود. در این حالت با افزایش تغییر شکل مهاربند یابد تا وسط ادامه می لنگر خمشیافزایش  درنتیجهتغییرمکان وسط تیر و 

، این افزایش لنگر پلاستیکیابد و به علت ثابت بودن افزایش می شدیداًعضو فشاری مهاربند، تغییر مکان جانبی وسط مهاربند به علت تشکیل مفصل پلاستیک 

 ن جانبی با کاهش نیروی محوری همراه خواهد بود.تغییرمکا
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P×δ=Mp=ثابت     ,   P↓=
Mp

δ↑
 

 

 

  

 یمهاربند عضو وسط در کیپلاست مفصل لیتشک تیدرنها و مهاربند کمانش و یفشار یروین شیافزا -36  شکل

 

. در این حالت است  AgFy توان به عضو وارد کرد برابرگیرد. حداکور نیروی کششی که میشود و عضو تحت کشش قرار میدر حالت باربرداری، نیرو صفر می

، در استصل پلاستیکی که در عضو ایجادشده به علت مف )صاف( نخواهد شد.مول حالت اول  گاههیچ عضو و مانندپسماند در عضو باقی می هایشکلتغییر 

Pcr)حالت اول کمتر خواهد بود نسبت بهبار بحرانی عضو  بارگذاری مجدد فشاری
'<Pcr).  مقدار

Pcr
'

Pcr
تابعی از لاغری عضو است. انجمن مهندسان سازه  

 ( رابطه زیر را ارائه کرده اند.SEAOCکالیفرنیا )

Pcr
'=

Pcr

1+

kl
r

2Cc

=
Pcr

1+
λ

2Cc

<Pcr     ,    Cc=√
2π2E

Fy
=

6440

√Fy

 

 پذیر مهاربندهای همگرا عوامل تاثیرگذار در رفتار شکل 9

 پذیر مهاربندها سه عامل تأثیرگذار است: در رفتار شکل

 لاغری مهاربند-1

) بعد لاغری عضو با پارامتر بی
Kl

r
باشد. این پارامتر شعاع ژیراسیون عضو می rطول عضو مهاربندی و  lضریب طول موثر،  k شود که در آنگیری می(  اندازه 

باشد. با افزایش های لاغر میهای هیسترزیس مهاربندهای لاغر دارای حلقهمهاربند تأثیر زیادی دارد. منحنیهای هیسترزیس در ظرفیت جذب انرژی و منحنی

. شودسختی سیستم می موجب افت سریعشود که مهاربند سریعتر کمانش کند و این شود. لاغری باعث میها کاسته میلاغری مهاربند از اتلاف انرژی آن

شتر باید سعی شود مهاربند حتی المقدور چاق )با لاغری کم( طراحی شود. منظور از لاغری کم یعنی لاغری در حدی است که بار پس برای اتلاف انرژی بی

 دهند.پذیری سازه را نیز افزایش میکمانشی کمتر از بار تسلیم باشد. مهاربندهای چاق ظرفیت شکل
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 شرایط انتهایی مهاربند-2

 ،جای اینکه دوسر مفصل اجرا شود، دوسرگیردار اجرا شودمهاربند بهتصالات انتهای مهاربند را گیردار یا مفصلی طراحی کند. اگر تواند اطراح بنا بر شرایط می

د)به دلیل وجود لنگر در شودر این صورت بجای تشکیل یک مفصل در وسط مهاربند، سه مفصل پلاستیک که دوتای آن دو انتهای مهاربند است تشکیل می

 دهد.مهاربند( و این پتانسیل اتلاف انرژی را افزایش میانتهای 

 

 شکل مقطع مهاربند-3

طی شکل است. از ازآن مقطع قوای و پسشده است با لاغری یکسان بالاترین اتلاف انرژی مربوط به مهاربندهای با مقطع لولهدر تحقیقاتی که تاکنون انجام 

  رای مهاربند گزینه بسیار مناسبی است. ب )قوطی شکل( این رو استفاده از جفت ناودانی

 

 افزار ایتبسسازی مهاربندهای همگرا در نرممدل 10

های لازم، به بررسی نحوه مدلسازی و ترسیم مهاربندهای همگرا و نکات مربوط به آن در سازی صحیح هندسه سازه فولادی و اعمال بارگذاریبا فرض مدل

2019ETABS پردازیم. باتوجه به اینکه مهاربندها در نمای جانبی سکککازه قاب ر یت هسکککتند، به جهت ترسکککیم ابتدا در نوار فوقانی آیکون می(e|
e
v

را  (

خاب کرده و در پنجره  خاب می Set Elevation Viewانت طه را انت حال از مسکککیر محور مربو Draw > Draw Beam/Column/Brace کنیم. 

 D)3n/Brace Objects(Plan,Elev,Objects > Beam/Colum سیم مهاربند می شکل زیر ظاهر میکنیم. پنجرهاقدام به تر شود که در ای مطابق 

 گردند.( تعیین میContinuousو گیردار:  Pinnedآن نوع مقطع انتخابی و شرایط انتهایی )مفصلی: 

  

 مهاربندها اتیخصوص میتنظ -37  شکل

 

در شکل زیر در یک دهانه مهاربند همگرای ضربدری و در دهانه دیگر  پرداخت. توان به ترسیم دستی مهاربند همگرابا استفاده از نشانک ظاهرشده می حال

 اند. مهاربند همگرای قطری ترسیم شده

 



 

 

3

3 

 

 یقطر و یضربدر یهمگرا مهاربند یدست میترس -38  شکل

 

 و هشتی دو راهکار وجود دارد: یترسیم دستی مهاربندهای شورون هفتبه جهت 

ها به کنیم تا در هنگام ترسیم نقاط انتهایی و وسط المانرا فعال می Line End and Midpointsگزینه  Draw > Snapp Options( از مسیر 1

 اند.یا لوزی را ترسیم نمود که در شکل زیر نشان داده شده یو هشت یون هفتتوان مهاربندهای به شکل شورطور خودکار نمایش داده شوند. در این صورت می

 

 

 یلوز یهمگرا مهاربند و یهشت و هفت شورون یهمگرا مهاربند یدست میترس -39  شکل

 

به چند قسمت تقسیم نمود. مطابق شکل زیر با وارد  توان المان رامی Frames  Edit > Edit frames > Divideبا انتخاب المان مربوطه از مسیر (2

شود. چنانچه بخواهیم از نقطه خاصی المان را دو قسمت کنیم با انتخاب المان و نقطه المان به دو قسمت مساوی تقسیم می ،در گزینه اول 2 نمودن عدد
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اضافی قصد داشته  grid lineاضافی وجود داشته باشد یا با ترسیم یک   grid lineرود که کنیم. گزینه سوم زمانی به کار میمربوطه گزینه دوم را فعال می

 به دوقسمت تقسیم شود. grid lineباشیم المان از محل تقاطع المان با 
 

به یکپارچه  اقدام Frames  Edit > Edit frames > Joinپس از ترسیم دستی مهاربندها بایستی با انتخاب دو قسمت جداشده از المان، از مسیر  :تذکر

 کردن المان نمود.
 

 

 قسمت چند به( ستون ای ریت) المان یبندمیتقس -40  شکل
 

 روش ترسیم سریع مهاربندها 1. 10

 قسمتشود. در ای به شکل زیر ظاهر میاز نوار ابزار کناری در منوی اصلی ایتبس پنجره )D3Plan,Elev,Quick Draw Braces( با انتخاب آیکون
Bracing توان نوع مهاربند را تعیین نمود. می 

 

 

 عیسر میترس در مهاربند نوع و مشخصات میتنظ -41  شکل

 

Eccen Back شود: مهاربند قطری که از راست به چپ ترسیم می 

Eccen Forward شود: مهاربند قطری که از چپ به راست ترسیم می 

Inverted V : مهاربند شورون هشتی 

Vمهاربند شورون هفتی : 

X مهاربند ضربدری : 

 شود.با انتخاب نوع مهاربند و کلیک بر روی دهانه مربوطه، مهاربند انتخابی به طور خودکار ترسیم می
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 تنظیمات عمومی پیش از طراحی 2. 10

شود که از قسمت پنجره تنظیمات مربوط به طراحی ظاهر می Design > Steel Frame Design > View Revise Preferencesاز مسیر 

Framing Type باشد ای میمربوط به برخی تنظیمات طراحی لرزه 10تا  3پذیری تعیین نمود. موارد ای و شکلتوان نوع قاب سازه را از نظر طراحی لرزهمی

 که در این مقاله مورد بحث نیست.

SMF : قاب خمشی ویژه 

IMF :  خمشی متوسطقاب  

OMF : قاب خمشی معمولی     

SCBF : شده همگرای ویژهقاب مهاربندی  

OCBF : شده همگرای معمولی قاب مهاربندی    

OCBFI : ایشده لرزههای جداسازیشده همگرای معمولی در سازهقاب مهاریندی  

EBF : شده واگرا قاب مهاربندی    

BRBF : تابقاب با مهاربند کمانش   

 

 

 یساختمان قاب نوع نییتع -42  شکل
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 تنظیمات اختصاصی مهاربندها 3. 10

 < Design > Steel Frame Designاز مسیر  شوند، سپستمامی مهاربندها انتخاب می Select > Select Object Type > Bracesاز مسیر 

View Overwrites شوند. های مربوطه به درستی تنظیم مینامه و نوع قاب، ویژگیانتخاب آیین مود. باتوان تنظیمات اختصاصی مهاربندها را مشاهده نمی

دهای ضربدری با مقطع متداول دوبل ناودانی، با توجه به نوع مقطع مورد استفاده در مهاربندها بایستی اصلاح گردد. به عنوان موال در مهاربن 25و  24تنها موارد 

 شوند.وارد می 7/0و 5/0ده برای کمانش حول محور قوی و ضعیف به ترتیب مقادیر مربوط به نسبت طول مهارنش

 

 

 مهاربندها اتیخصوص میتنظ -43  شکل

 

 Steel Stressای به نام جرهباشد. در این حالت پنکلیک بر روی آن قابل مشاهده میپس از تحلیل و طراحی اطلاعات مربوط به مهاربندها با راست

Information است. بارها نمایش داده شدهای از طراحی عضو مورد نظر در هریک از ترکیب شود که خلاصهباز می 

 

 پرسش و پاسخ

 تفاوت سیستم مهاربندی زانویی با قطری چیست؟ (1

 آن، در کیالاست مفصل لیتشک با و بوده لازم یریپذشکل کنندهنیتأم که باشدیم زین ییزانو عضو کی شامل یقطر عضو برعلاوه ییزانو مهاربند ستمیس

 .نمود استفاده دوباره و ریتعم ار یمهاربند ستمیس ییزانو عضو ضیتعو با توانیم ،یخراب صورت در جهینت در. مانندیم یباق کیالاست حالت در اعضا هیبق

 

 بهترین نوع مهاربند همگرا کدام است؟ (2

 یکل طور به. باشندیم بحث قابل یمعمار و ییاجرا یهاتیمحدود ،یریپذشکل ،یسخت نظر از و دارند یبخصوص بیمعا و ایمزا همگرا یمهاربندها از کیهر

 .باشندیم همگرا یمهاربندها نیترمتداول و نیبهتر شورون و یضربدر یمهاربندها

 

 توان انجام داد؟میای شورون چه اقدامی کننده تیر در مهاربندهای همگربه منظور کاهش نیروی نامتوازن (3

 شوند.های دوخت یا استفاده از سیستم ترکیبی مهاربندهای شورون هفتی و هشتی به عنوان دو راهکار مؤثر شمرده میاستفاده از ستون
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 ای ممنوع است؟آیا استفاده از مهاربند همگرای دروازه (4

ستفاده از آن به دلیل پتانسیل حرکتنامهییننامه نشده و ضوابط آای فعلاً وارد آیینخیر. مهاربند همگرای دروازه های خارج از صفحه ای ندارد، اما بایستی از ا

 و غیراقتصادی بودن تاحد امکان اجتناب نمود.

 

 شکل در مبحث دهم مقررات ملی چیست؟ kدلیل ممنوعیت استفاده از مهاربندهای  (5

برند که امری تون را بالا میسشکل و اتصال مستقیم به وسط ستون، این مهاربندها پتانسیل ایجاد مفصل پلاستیک در  kبه دلیل شکل ظاهری مهاربندهای 

 نامطلوب و خطرناک است.

 و جمع بندی نتیجه گیری

های مختلف مورد مقایسه قرار گرفتند. مهاربند ضربدری نوع مهاربند همگرا از نظر ویژگی 6شد و  در این مقاله سیستم مهاربندی همگرا مورد مطالعه قرار داده

باشد. از این های معماری میپذیری کم و محدودیتترین نوع مهاربند همگرا معرفی شد که در مقابل دارای شکلبا بالاترین میزان سختی به عنوان متداول

ناپذیر با پوشش های نوین مهاربندی نظیر مهاربندهای کمانشهای ایجاد بازشو و سیستمشتی با مرتفع ساختن محدودیترو، مهاربندهای شورون هفتی و ه

بندی قهو طب Kهای همگرا مورد بررسی قرار گرفتند. براساس مبحث دهم مقررات ملی ساختمان، دلیل ممنوعیت استفاده از مهاربند دیگر معایب سیستم

ر نهایت دپذیری شرح داده شد. همچنین، رفتار هریک از مهاربندهای همگرا در هنگام وقوع زلزله مورد مقایسه قرار گرفت. از نظر شکلمهاربندهای همگرا 

 ارائه شد. ETABSافزار نکاتی در مورد ترسیم دستی و سریع انواع مهاربندهای همگرا در نرم
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شد و هرگونه کپی برداری سازه محفوظ می با سبز  سی  شرکت مهند ، تقلید یا باز  کلیه حقوق مادی و معنوی این اثر برای 

 نشر غیر قانونی بوده و تحت پیگرد قانونی قرار خواهد گرفت.
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